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A large portion of this issue is dedicated to what 
we believe is one of the biggest updates to CC we’ve 
seen in quite a while. The funny thing is: it’s not an 
Adobe update, but a Google one. By making the 
fantastic Nik Collection free, they’ve made one of 
the world’s best Photoshop plugins available to all!
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powerful proxy workflows will 
enable you to work on low-
quality proxy versions of your 
video then render at the end 
of the project; so in theory it’ll 
be easier to work with heavy 
8K, HDR and HFR media even 
on lightweight machines. 
Premiere also sports Enhanced 
Lumetri Colour tools.

After Effects CC will get a 
new video and audio preview 
engine, meanwhile, with 
improved performance under 
the hood and instant feedback 
for any changes you make.

If you want to improve 
the sound in your videos 
but don’t have a clue about 
sound enhancement tools, 
improvements to Audition 
should make things easier. The 
new Essential Sound Panel is 
a pared-down version of the 
program that simplifies the 
process for beginners.

Anyone who edits 
videos is likely to see 

significant improvements to 
Adobe’s roster of video-editing 
apps: Premiere Pro, After 
Effects, Character Animator 
and Audition. Adobe has 
revealed new features across 
its Creative Cloud tools for 
video editing, motion graphics 
and audio.

In the next release of Creative 
Cloud – due in early summer – 
Premiere Pro CC will add new 
virtual reality capabilities, 
including a ‘field of view’ mode 
for spherical stitched media. 
Updates to Premiere will allow 
you to edit during import, so 
you can get straight to work 
while adding more files in 
the background. In addition, 

NEWS
CC VIDEO-EDITING 
UPDATES
Background imports, preview-based 
editing, new VR effects and more



NIK COLLECTION RIP?
As this month’s cover 
story celebrates, Google’s 

Nik Collection is now free to 
download. But one wonders 
why Google has done this. A 
statement on the site says: “As 
we continue to focus our long-
term investments in building 
photo-editing tools for mobile, 
including Google Photos and 
Snapseed, we’ve decided to 
make the Nik Collection desktop 
suite available for free, so that 
now anyone can use it.”

This suggests that Google 
is redirecting resources 
away from the Nik Collection. 
Software needs regular 
updates to keep it compatible 
with your computer and 
software, though, so there 
may come a day when the Nik 
Collection no longer works with 
your system. (Already it’s not 
compatible with Elements 14.) 
Enjoy it while it lasts!

IMPROVED ADOBE STOCK FUNCTIONALITY
Adobe’s new Stock feature, which gives you 
access to 50 million images and graphics files, will 

see improvements in upcoming updates to Lightroom 
and Bridge. In a new Creative Cloud release expected to 
become available in early Summer, Adobe Stock will have 
enhanced connections with Creative Cloud apps, while 
new workflows will enable Adobe Bridge and Lightroom 
users to contribute to the Adobe Stock marketplace 
directly from within those applications. You will also be 
able to access royalty-free video stock.

The Nik Collection is now free – 
but what will happen when you 
update your computer?



It’s the ultimate Photoshop plugin – 
and now it’s free for everyone! Get to 
grips with the Nik Collection and take 
your images to soaring new heights

The Nik Collection has long been 
regarded as one of the finest photo 

editing plugins available for Photoshop and 
Lightroom. But the price had turned many off 
trying it. A few years ago it would’ve cost $500 
– a hefty outlay for anyone. In 2012, Google 

purchased Nik and brought the price down 
to a more accessible $150. But now, Google’s 
decided that they no longer need to charge 
anything for the Nik collection. It’s free for 
anyone to download – and if you bought it in 
2016, they’ll give you a refund.

YOU CAN 
MASTER...

THE NIK 
COLLECTION



This is a really big deal. 
Seriously: any Photoshop 
owner should stop what 
they’re doing right now and 
go and download the Nik 
Collection. For photographers, 
it’s arguably the biggest thing 
to happen to CC since – well, 
since it became CC. There’s 
also a question mark over 
whether, now that it’s free, 
Google will keep the collection 
up to date with the latest 
versions of Photoshop and 
Lightroom. A word of warning: 
it may not work forever. Better 
to start enjoying it right now.

So what’s all the fuss about? 
The Nik Collection offers some 
of the classiest effects and 
presets out there – and those 
who like their one-click edits 
will find plenty to sink their 
teeth into. Sure, with enough 
know-how you can probably 
recreate most, if not all of the 
effects in Photoshop. But why 
bother when the collection 
does such a swift, neat job for 
you? What’s more, there’s a 
gentle learning curve and the 
plugins share lots of keyboard 
shortcuts with Photoshop, so 

it doesn’t take long to pick up, 
especially with a few pointers. 
Delve a little deeper into the 
programs and there are plenty 
more delights to discover. 

That’s where this month’s 
cover story comes in. We’ll 
get you up and running with 
each of the plugins in the Nik 
Collection. There’s Analog 
Efex Pro for adding in retro 
borders, film effects, light 
leaks and other film-inspired 
imperfections. Then there’s 
Color Efex Pro 4 for a range 
of cool color treatments. HDR 
Efex Pro excels at merging 

exposures and tone mapping 
for a range of eye-popping 
HDR treatments. Dfine 
and Sharpener Pro tackle 
noise and sharpening, while 
Viveza is built for selective 
adjustments. And perhaps 
the jewel in the crown is 
Silver Efex Pro, a classic 
black-and-white converter 
capable of producing the best 
monochrome effects you 
can find. Over the next few 
pages, we’ll explain how the 
collection works – and how to 
fit them into your Photoshop 
or Lightroom workflow.

COLOR 
EFEX PRO

SHARPENER 
PRO

Use the outstanding Nik Collection plugins inside Photoshop or Lightroom, or open any you like 
as a stand-alone program to work on an image directly. The results are brilliant

DFINEVIVEZA SILVER 
EFEX PRO

HDR 
EFEX PRO

ANALOG 
EFEX PRO



IN LIGHTROOM… 
Right-click on any image and choose 
Edit In, then select a plugin from the 

collection. Three options appear. In most 
instances Edit A Copy With Lightroom 
Adjustments is best: it creates a copy 
of the original file with any Lightroom 

edits applied, so your original file stays 
untouched. Edit A Copy will also make 
a duplicate, but without applying any 

changes previously made in Lightroom. 
The third option, Edit Original, should 

be used with care, as it overwrites your 
original image without making a copy.

Go to www.google.com/nikcollection to download the collection (available for Windows 
or Mac OS X), then install it. Upon installation, the program will detect whether you have 

Lightroom or Photoshop (or both) and add plugins to the software. (HDR Efex Pro doesn’t 
work with Lightroom.) You can also use any of the Nik Collection range as a stand-alone 

program. But using them in Photoshop offers the most control, as you have the option to 
make edits on separate layers. So not only does everything remain editable, but you also 

have the option to apply effects selectively with layer masks. If you want to take advantage 
of this, you can click the Brush button to go back to Photoshop and paint a mask.

IN PHOTOSHOP… 
Go to Filter > Nik Collection to choose 

from the entire range of plugins. There’s 
no need to duplicate your background 

layer beforehand, as a new layer is 
automatically created when you apply 
the effect (although if you don’t want 
this, you can change it in the settings). 

This means every change is editable 
later. Even better, the plugins are 

compatible with Smart Objects, which 
means you can re-enter and edit the 

plugin settings at any time by double-
clicking the Smart Filter name.

HOW TO DOWNLOAD



Anyone who likes vintage effects (and going by the 
success of Instagram, that’s just about everyone) 

will find plenty to enjoy in Analog Efex Pro. There’s a whole 
host of film-inspired imperfections like light leaks, dust and 
scratches, messy borders, vignettes and blur effects.

Get the retro look with faded  
colors, vintage effects and  

old-fashioned imperfections

BEFORE

ANALOG EFEX PRO

 DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/rpzyay ON YOUR PC OR MAC



03 BUILD A CAMERA
Click the top-left 

button again to access the 
tools and combinations. 
Click Camera Kit. This 
shows all the tools on 
the left. You can click the 
plus sign next to any to 
add them in and enhance 
your image. We’ve added 
Dust and Scratches, then 
tweaked the positioning. 
Once done, click OK.

02 ADJUST THE 
SETTINGS

Once you’ve chosen a 
preset – we picked Vintage 
Camera 3 here – you can 
fine-tune the settings on 
the right. You can also turn 
off any parts of the effect 
you dislike by clicking the 
ticks. We’ve toned down 
Detail Extraction here. 
Double-click any individual 
slider to reset it.

01 CHOOSE A PRESET
Open an image in 

Photoshop. Right-click the 
layer and choose Convert 
To Smart Object. Go to 
Filter > Nik Collection > 
Analog Efex Pro 2. Click OK 
when the warning shows. 
Click Classic Camera then 
experiment with the tool 
combinations, each of 
which opens up several 
presets to play with.

STEP BY STEP: BUILD AN ANALOGUE EFFECT



THE ANALOG EFEX PRO INTERFACE
All the Nik Collection plugins sport a similar interface and 

shortcuts – so once you crack one, the others will swiftly follow...

PRESETS
This is usually the place to 

begin. Scroll through the list 
and experiment with different 
presets. Once you’ve chosen a 
look you like, you can go on to 

modify any of the settings. Here 
the different presets are accessed 

via the top-left button.

ZOOM CONTROLS
Click Zoom to jump to a specified 
magnification. You can also tap 

Space to zoom in, then hold Space 
and drag to move around the image. 
You can use Cmd/Ctrl + or - to zoom 
in or out, and Cmd/Ctrl+0 (zero) to 
fit on screen. Press F to make the 

plugin window fit your screen.

COMPARE
The buttons here let you view a 

before-and-after of your image as 
a split-screen or temporarily full-

screen (click and hold Compare, or 
hold P). The arrows at top left and 
right let you minimise either panel 
to make the image window larger. 

Press Tab to hide or reveal both.

TOOLS
Click the arrow at top 
left to open the Tools 

and Tool Combinations 
panel. Tools lists all the 
different effects that 
can be applied, while 

Tool Combinations are 
ready-made ‘recipes’ 
that combine several 

tools into a distinct look.

CUSTOM/IMPORTED/
HISTORY

Custom lets you save presets. Once you work 
up an effect you like, it’s worth saving it here 

by clicking the plus icon. That way you can 
add the same treatment to other images 

with a single click. The Imported tab lets you 
manage presets downloaded from the web, 

while History lets you go back to previous 
states, just like in Photoshop.

TOOL SETTINGS
These settings let you fine-tune 
each effect. The options change 
depending on the preset chosen 
in the Tool Combinations menu. 
To add whichever tools you like, 

choose Camera Kit in the Tool 
Combinations list, then click the 

plus sign next to each tool in 
the list on the left to add them 

into the mix.



CLASSIC CAMERA 9
A range of classic effects apply authentic color 

shifts, vignetting… even dust and scratches.

ANALOG EFEX PRO: FOUR OF THE BEST

MOTION 9
From zoom burst effects to twisted streaks, 

you can blur in different directions.

VINTAGE CAMERA 3
Borders for different films and print types 

can be added and randomized.

DOUBLE EXPOSURE 2
This lets you add a second image like an in-

camera double, then control the balance.

With over 80 presets in this plugin there’s plenty of choice. 
Here’s a quartet of our favorites to get you exploring...



All of the plugins in 
the Nik Collection 

feature Control Points in 
one form or another. These 
let you selectively adjust 
areas. Most Photoshop users 
will be familiar with making 
selections or using masks to 
isolate areas for selective 
adjustments, but Control 

Points are different. You 
simply click on a point , adjust 
the circular area to fit over 
whatever you want to target, 
and the software will work 
out what you want to adjust 
by seeking out similar tones. 
It’s both clever and easy!

Although all the plugins 
in the collection feature 

Control Points, Viveza is the 
one that’s almost completely 
dedicated to them. It’s a good 
substitute for Adjustment 
Layers, and useful when you 
don’t want to spend time 
painstakingly making masks. 
A few clicks can define an 
area like the foreground here 
for quick adjustments.

The Nik Collection plugin dedicated to selective adjustments is 
a great way to learn techniques that apply across the board

VIVEZA

BEFORE

 DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/rpzyay ON YOUR PC OR MAC



03 DUPLICATE 
AND GROUP

Add another point over 
the rock in the foreground 
and lift the structure to 
pull out more texture. 
Alt-drag the point to copy 
the adjustment over to 
another rock nearby. If 
you want to adjust several 
points as one, Shift-click to 
highlight them then click 
the Group button.

02 ALTER THE TONES
Use the set of sliders 

hovering over the photo 
to adjust the effect inside 
the area affected by the 
Control Point. Here we’ve 
used it to darken down the 
blue sky. Next click Add 
Control Point again and 
make a second point over 
the other half of the sky. 
Adjust the brightness to 
darken it too.

01 MAKE A 
CONTROL POINT

Right-click the layer and 
choose Convert To Smart 
Object. Go to Filter > Nik 
Collection > Viveza. Click 
Add Control Point then click 
the sky. Use the top slider 
connected to the Control 
Point to resize the area. 
To see what is affected 
(in white), click the square 
icon in Control Point List.

STEP BY STEP: GET TO GRIPS WITH CONTROL POINTS 



For many pros, 
Silver Efex Pro 2 is 

the only way they’ll use to 
strip their images of color. 
Aside from being a great 
black-and-white converter, 

it’s also convinced a lot of 
photographers who were 
dubious about the ability 
of digital to match the 
look and feel of old-school 
monochrome. The interface 

follows the same pattern 
as other programs in the 
collection. Begin by selecting 
a preset from the 38 on offer, 
then go on to fine-tune the 
settings to perfect the look.

Discover one of the greatest digital tools 
for converting images to black and white

SILVER EFEX PRO



01 THE PRESETS
There are 38 preset effects to 

the left side. These can be filtered 
into smaller groups if you like, but 
it’s usually easiest to scroll through 
the whole list. Each gives your image 
a certain look, with variations in 
texture, detail, contrast, brightness 
and grain. You can search for extra 
presets online and install them with 
the Imported tab.

FIVE THINGS TO LOVE ABOUT SILVER EFEX PRO



02 CONTRAST CONTROL
Mono conversions 

invariably benefit from a 
boost in contrast, and this is 
something Silver Efex excels 
at. Aside from the presets, 
there are several useful 
controls. The Contrast slider 
works much like the one 
in Camera Raw – but click 
its arrow for more options. 
Amplify Whites and Amplify 
Blacks increase contrast 
in either the highlights or 
the shadows. Soft Contrast 
creates a dreamy glow.

If the changes leave the 
blacks or whites short of 
detail, claw some back with 
Tonality Protection. There’s 
also a Levels And Curves 
control under Film Types.

FIVE THINGS TO LOVE ABOUT SILVER EFEX PRO



FIVE THINGS TO LOVE ABOUT SILVER EFEX PRO
03 STRUCTURE

The Structure controls 
(click the Structure arrow 
to reveal) tease out extra 
detail and enhance textures. 
The main Structure slider is 
similar to Clarity in Camera 
Raw and Lightroom in that 
it boosts midtone contrast. 
The advantage here is that 
you can enhance shadows, 
midtones and highlights 
independently. This is useful 
when you want to improve 
flat detail in one part of the 
tonal range. Here, increasing 
Shadows allows us to lift 
the texture in the land while 
holding back the lighter sky.



04 FILM 
EMULATION

If you love the 
look of certain old 
camera film stocks, 
you might be able 
to replicate them 
under Film Types. 
There are 18 films on 
offer, each designed 
to replicate the 
tones, contrast and 
grain of their analog 
forebears. The 
higher the ISO, the 
more pronounced 
the image noise. 

FIVE THINGS TO LOVE ABOUT SILVER EFEX PRO



05 TONING
Adding a color wash 

to black-and-white images is 
something you can do with 
the excellent Photographic 
Toning Gradient Maps in 
Photoshop. But there’s a 
real authenticity to the 
Toning effects in Silver 
Efex Pro. The warming and 
cooling tones are especially 
good. Look for them under 
Finishing Adjustments.

FIVE THINGS TO LOVE ABOUT SILVER EFEX PRO



Dfine is a simple plugin 
that helps you fix 

graininess and color noise 
in your high-ISO images. At 
its simplest, all you have to 
do is launch the plugin and 
wait a few seconds while it 
automatically analyses the 
image and fixes the noise. 
Job done. But if you want 
more control, you can work 

through two stages to fix 
noise manually, using the 
buttons on the right of the 
Dfine interface.

Measure can be done either 
automatically or manually. 
The Automatic setting works 
well most of the time. Next, 
switch to Reduce. Here you 
can change the amount of 
Contrast and Color noise 

reduction. Double-click your 
image to jump to 100% while 
assessing the results.

DFINE
Clear up grainy images the easy way with the 

Nik Collection’s automated noise reduction plugin

BEFORE



Sharpener Pro, as you’ll 
have guessed, tackles 

image sharpening. It actually 
consists of two plugins: RAW 
Presharpener, which you run 
at the start of your workflow, 
and Output Sharpener, which 
should be your very last step 
after resizing a image for a 
certain medium like a print or 
a website.

While the results are good, 
there’s little benefit to using 

RAW Presharpener over 
Photoshop or Lightroom’s 
own tools, which are just 
as effective. The only real 
advantage is if you want to 
apply sharpening selectively 
with Control Points.

Sharpener Pro’s Output 
Sharpener is the more useful 
of the two, as crucially, it lets 
you define a specific medium 
for output, like Inkjet for print 
or Display for viewing on-

screen. Once you’ve made 
a choice, you can use the 
sub-menus for each output 
to fine-tune the sharpening 
and pull out extra detail.

Apply capture and output sharpening to crisp up the details

SHARPENER PRO 3
BEFORE



HDR Efex Pro (not available within Lightroom) is 
up there with the best HDR software. It lets you 

merge a set of exposures (like a bracketed set of three 
images shot at 1-stop intervals) to create a single frame 
with increased dynamic range. This is especially useful in 
high-contrast scenes, as you can tease out details in both 
shadows and highlights.

HDR is known for a certain hyper-real look. With HDR 
Efex Pro, you can get both natural and stylised results.

As well as using the plugin to merge exposures, you can 
also apply tone mapping effects to a single image to give 
it the HDR look.

Whether you like your HDRs natural or super-stylized, Nik’s HDR 
plugin excels at both merging exposures and tone-mapping

HDR EFEX PRO

BEFORE

 DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/rpzyay ON YOUR PC OR MAC



03 REVEAL 
THE DETAILS

Once you’ve chosen a 
preset, you can go on to 
fine-tune the settings. 
HDRs often benefit from 
selective adjustments. 
You can make these in the 
plugin using Control Points. 
Click to add a Control Point, 
then use the sliders to 
adjust the area covered 
and the tones within.

02 CHOOSE A LOOK
Once you’re happy 

with the merge settings, 
click Create HDR. Once 
the images are merged, 
you can experiment with 
the 28 presets on the left 
side. Here, Deep 2 gives a 
nice result by bringing out 
detail in the shadows and 
highlights without looking 
the effect going too far 
and looking hyper-real.

01 MERGE EXPOSURES
To merge a set of 

exposures, go to File > 
Automate > Merge to 
HDR Efex Pro. Click Open, 
load in your set and click 
Merge Dialogue. If there 
is ghosting (movement 
between frames), click 
on a frame to choose for 
reference, then zoom in 
and choose a ghosting 
strength to fix it.

STEP BY STEP: CREATE AN HDR IMAGE



OUTDOOR 2
This one gives natural-looking results 

that don’t scream ‘HDR’

HDR EFEX PRO: 4 OF THE BEST

GRANNY’S ATTIC
A stylised result packed with structure 

and a lovely warm tone

BW ARTISTIC
HDR’s can look good in mono, and it helps to 

steer clear of over-saturated colors

DEEP 2
Rich, natural tones and punchy colors – 
a good starting point for further edits

Love them or hate them, HDR effects certainly give your 
images impact. Here are four of our favorite looks



Color Efex offers a 
range of filter effects 

that help to stylize your 
images. It follows a similar 
pattern to the other ‘Efex’ 
plugins: presets and tools sit 
on the left of the interface, 

while the right side lets you 
fine-tune settings for each 
effect. However, there are 
only a handful of finished 
‘recipes’ to choose from.

Instead, the emphasis in 
Color Efex is more on building 

your own custom effects by 
applying a series of filters. 
With useful effects like 
Polarization and Pro Contrast 
as well as lots of color toning 
tools, there’s plenty to enjoy. 
Here’s how it works...

Correct colors, apply filter effects and give your 
images extra impact with this fun plugin

BEFORE

COLOR EFEX PRO

 DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/rpzyay ON YOUR PC OR MAC



03 APPLY AND MASK
If you think you 

might re-use this combo of 
filters, click Save Recipe on 
the right. Once done, click 
OK to exit and go back to 
Photoshop. One advantage 
to applying the effect to a 
Smart Object layer is you 
can paint with black on the 
mask to selectively hide it. 
Here we’ve reduced it over 
the windmill slightly.

02 ADD ANOTHER 
EFFECT

Once you’re happy with the 
initial filter effect, you can 
go on to add others. Don’t 
click on any other filters 
just yet, as this’ll overwrite 
the first. Instead click the 
Add Filter button on the 
right before choosing 
another. We’ve added Pro 
Contrast here to give the 
tones extra punch.

01 EXPERIMENT 
WITH FILTERS

Start by going to Filter 
> Nik Collection > Color 
Efex Pro 4. Go to the list 
of filters on the right, click 
All or sort by category and 
experiment with any that 
catch your eye. We’ve gone 
for the Polarization filter, 
which mimics the effects 
of a polarizer by darkening 
the blues in the sky.

STEP BY STEP: CREATE YOUR OWN LOOK



WARM SUNSET RECIPE
Gives images a soft quality that works well for 
portraits, although you may need to rein it in

COLOR EFEX PRO: 4 OF THE BEST

BLEACHED PORTRAIT RECIPE
A classy desaturated look. For a light, airy 

finish, increase Brightness in Bleach Bypass

DYNAMIC SKIN SOFTENER FILTER
Get super-smooth skin in seconds, then adjust 

Brightness and Contrast to suit the image

VIGNETTE: BLUR FILTER
Place over a face to draw attention towards 
it. We also used a Pastel filter for cool colors.

With a range of recipes and tons of filter effects there’s 
almost too much choice, but here are our picks



FANTASY 
LANDSCAPES
James Paterson 
explains how to build 
your own fantasy 
scene by combining 
elements from several 
different images 

Love landscapes, but never 
seem to chance upon the 

perfect scene? Then why not 
make your own fantasy location? 
With a few simple Photoshop skills, 
you can combine elements from 
a range of images into a single, 
perfectly composed frame – and 
you get to choose exactly where 
everything goes: a tree here, an 
animal there, a snowy mountain, 
perhaps even a few sun rays to 
add to the drama.

If you want to piece together 
your own personal paradise, the 
first thing to learn is how to cut 
out parts of an image. But beyond 
this, the key to success is matching 
up the colors and tones so that 
everything looks like it belongs 
together. Any old Photoshop 
dabbler can cut out and combine a 
few images, but it takes a proper 
maestro to unite those elements 
as a seamless, believable whole. 
Adjustment layers are one of 
the best tools for the job, as they 
allow you to tone either the entire 
composite or, with clipping masks, 
individual elements instead. 

PROJECT INFO

You’ll learn
 Make a composite 

landscape by cutting 
out and blending 
several images 
together

You’ll need 
 Photoshop CC

It’ll take 
 One hour

 DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/rpzyay ON YOUR PC OR MAC

WATCH THE VIDEO
http://tiny.cc/j77xay



02 COMBINE 
THE IMAGES

Grab the Move Tool, and 
check Auto-Select Layer 
and Show Transform 
Controls. Drag the 
mountains image onto 
the waterfall image, go 
to the Layers panel and 
drag this layer below 
the top layer. Click 
the bounding box and 
position the mountains.

03  BLEND IN  
THE TREE

Open sky.jpg, copy it 
and drag the layer to 
the bottom. Open tree.
jpg, copy in and position, 
then double-click the 
layer. Move the right 
side of the top Blend If 
slider inwards to hide 
the background. Alt-
drag the slider to split it 
for a smooth transition.

01  REMOVE  
THE SKY

Open waterfall.jpg. 
Paint the sky with the 
Quick Selection Tool. 
Click Refine Edge in the 
options and increase 
Radius to improve the 
edge. Set Output to 
Layer Mask and click OK. 
Open mountains.jpg 
and mask out the sky 
in the same way.

BUILD AN IMAGINARY LANDSCAPE



05  TONE THE  
LAYERS

On the waterfall layer, 
add an adjustment layer 
and choose Photo Filter. 
Click the Clip To Layer 
icon in the Properties 
panel and add a Warming 
Filter. Adjust the other 
layers to match tones. 
Set Levels, dragging the 
Output black slider in to 
add haze.

06  MAKE  
LIGHT RAYS

Add a layer above the 
tree. Shift-paint a 
white line with a soft 
round brush. Pick the 
Move Tool and Ctrl-
drag the box corners 
to skew the shape. 
Lower the opacity and 
add a mask to soften 
the edges. Repeat to 
add more rays.

04  ADD THE 
ANIMALS

Click the Add Mask icon 
in the Layers panel. Use 
a black brush to tidy up 
edges around the tree. 
Open deer.jpg; copy a 
deer to the main image. 
Open the bird images 
and copy. Use the Blend 
If sliders, setting the 
drop-down to Blue to 
remove the sky.

BUILD AN IMAGINARY LANDSCAPE



 DOWNLOAD THE PROJECT FILES HERE http://tiny.cc/rpzyay ON YOUR PC OR MAC

WATCH THE VIDEO
http://tiny.cc/dc8xay

PROJECT INFO

You’ll learn
 Four ways to change 

a dress color or pattern

You’ll need
 Photoshop CS4 

or above

It’ll take 15 minutes

ALTER SELECTED 
COLORS WITHIN 
YOUR PHOTOGRAPH
From making simple hue 
adjustments to adding 
detailed floral patterns, 
learn how to control and 
modify colored objects 
in your images

Photoshop offers 
several superior 

tools for altering colors 
in your photos. From 
Lab Color, to Adjustment 
Layers, Camera Raw and 
more, with a few simple 
skills you can alter colors 
to any shade you  like. You 
can even alter textures 
and add patterns. In this 
video tutorial, we’ll show 
you four ways in which it 
can be done...

BEFORE

BEFORE



If you’d like to watch the  
complete course now, get the 
app from the Apple App Store

Learn how to prepare colors 
for printing with Lightroom’s 
Color Management tools

LEARN LIGHTROOM TODAY!

LIKE THIS? NOW AVAILABLE ON 
THE APPLE APP STORE BIT.LY/TYLRAPP

BUY
NOW!

WATCH THE VIDEO
http://tiny.cc/f07xay



Your quick-start guide and reference  
to image editing in Photoshop

If you’re relatively new to editing in 
Photoshop, or you just don’t know 

where to begin, then this section is the best 
place to get started. Over the next nine pages, 
you’ll find an overview of the different versions 
of Photoshop available; a breakdown of the 

typical image-editing workflow in Photoshop; 
an overview of raw file editing; a guide to the 
six most useful layers; and a glossary of the 
most useful shortcuts. This guide condenses 
most of the tools and techniques you’ll use 
every time you import a new roll of pictures.



Lightroom combines 
the professional raw-
processing tools in the 

more expensive Photoshop
CC with the asset-organizing
powers of the cheaper 
Photoshop Elements.
Lightroom is available as 
a traditional boxed copy 
(Lightroom 6), and as part of 
a Creative Cloud subscription 
(Lightroom CC). Essentially,
the applications are the same, 
except Lightroom CC has 
Creative Cloud support, ongoing 
updates, and access to the 
mobile and web workflows.

LIGHTROOM 6
£100.07 OR INCLUDED WITH 
CREATIVE CLOUD WINDOWS, OS X

Lightroom Mobile is 
the lightweight iPad, 
iPhone and Android 

version of the application, 
integrated with Lightroom CC 
but not Lightroom 6. To use 
Lightroom Mobile you need 
to sign up for an Adobe ID so 
that you can access the Adobe 
Creative Cloud. This enables 
you to create a collection 
of photos on your desktop 
copy of Lightroom and sync 
them via the Creative Cloud 
to Lightroom Mobile on your 
portable devices. You can then 
use Lightroom Mobile to edit or 
add ratings to your pictures.

LIGHTROOM MOBILE
INCLUDED WITH CREATIVE CLOUD
IPHONE, IPAD, ANDROID 

Photoshop is the software of choice for most professional 
and non-professional photographers. Beyond the standard 
photo-editing features, it boasts a vast array of more 

creative tools and filters. Layers are one of the key differences 
between Photoshop and Lightroom. They enable you to mask out 
selected parts to build up increasingly sophisticated images.

PHOTOSHOP CC 
£8.57/$9.99 PER MONTH WINDOWS, OS X  

Elements is the consumer variant of Photoshop, and 
contains many of its key tools and features within a 
simplified interface. It’s limited, but it does provide access 

to layers for those who have switched to a Lightroom workflow.

ELEMENTS 14 £79.10/$99.99  WINDOWS, OS X



Adobe Shape enables 
you to turn photos and 
sketches into beautiful 

vector shapes for use in your 
designs or artwork. The app 
smooths out jagged edges in 
images, resulting in gorgeous 
vectors that are endlessly 
scaleable, just as if you’d drawn 
them by hand with the Pen tool. 
Make a shape with the mobile 
app and the next time you open 
Photoshop on your desktop, the 
shape will sync to your Library. 
Drag it in to any document to 
add color and make further 
adjustments.

ADOBE SHAPE
FREE
IPHONE, IPAD, ANDROID 

Adobe Brush enables 
you to make your 
own custom brushes 

from photos or sketches for 
use in Photoshop, Illustrator 
or the Sketch app. The most 
successful subjects are usually 
those that can be easily 
isolated, such as a splash 
against white, or a leaf against 
the sky. You can capture objects 
for your brush tips using your 
device’s camera, choose from 
your camera roll, or use your 
Creative Cloud library. Once 
captured, you can then fine-
tune the look of the tip and 
apply brush settings.

ADOBE BRUSH
FREE
 IPHONE, IPAD, ANDROID 

Mix enables you to merge two photos together 
to create a composite image. It offers a simplified 
compositing process that makes it easy for beginners 

to start combining an object from one image with a background 
from another. You can then send the composite to Photoshop 
for further edits. If you like, you can also use Mix to edit a single 
image. It offers a few simple tonal adjustments and more 
complex edits such as Content-Aware Fill.

If you ever need help 
selecting coordinated colors 
for your designs, try using 

Adobe Color. It enables you to create 
color themes from photos taken on 
your mobile device. This could be 
anything from a scene in your local 
park to a famous painting. So if you 
come across an inspirational scene, 
capture the colors and save them.

ADOBE PHOTOSHOP MIX
FREE IPAD, ANDROID

ADOBE COLOR
FREE IPHONE, IPAD, ANDROID 



As the name suggests, this app enables you to paint 
freehand using a selection of brushes, colors and other 
tools. However, Sketch is more than just a painting 

app. It also enables you to connect with like-minded creatives, 
so you can follow artists and see their work updating. Once 
you’re done sketching the image on your iPad, you can upload 
to the Sketch community or continue working on the image 
in Photoshop CC. You can also bring in brushes made with 
Adobe Brush, and for those who can’t paint, there’s an option 
to overlay images so you can trace over a photo. Sketch is 
compatible with Adobe’s pen and ruler hardware, Ink and Slide, 
but you can get great results with your finger.

Fix is a retouching app 
for altering portraits and 
fixing marks or blemishes 

in your photos. Intelligent facial 
recognition locks onto eyes, lips 
noses and chins, making it easy to 
tweak a smile, tuck in a jawline or 
enlarge eyes, should you wish.

ADOBE PHOTOSHOP SKETCH
FREE IPAD

PHOTOSHOP FIX
FREE  IPAD 

If you’re a designer 
who wants to build 
a quick layout for a 

web or print page, then Comp is 
the ideal place to start piecing 
ideas, images and text together. 
You can draw common design 
elements such as text or image 
boxes with quick gestures. For 
example, a couple of squiggly 
lines with a dot makes a 
header, and a cross makes an 
image box. It makes it easy to 
mock up a layout in seconds. 
You can then add words and 
graphics. The app even spits 
out a Photoshop, Illustrator or 
InDesign document.

ADOBE COMP CC
FREE IPAD

Behance is the online 
social space for 
creatives to share 

and showcase their portfolios, 
connect with one another, 
and find work. With work 
from the best photographers, 
digital artists and designers 
out there, it’s also a great 
place to find inspiration for 
a new project. If you’re a 
Creative Cloud subscriber you 
can set up a Behance page in 
minutes. The Behance app 
for iOS devices enables you to 
manage your page, while the 
Creative Portfolio app provides 
a polished portfolio.

BEHANCE 
CREATIVE PORTFOLIO
FREE IPAD, IPHONE
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The image-editing process begins as 
soon as you’ve transferred your photos 

from your memory card to your computer.
The first stage is to begin sifting 

through your pictures to discover which are 
the keepers. The image organizer that comes 
with Photoshop is ideal for this task. Adobe 
Bridge has controls for keywording, rating and 
filtering your images, and there are handy tools 
for batch renaming files, creating panoramic 
stitches, making contact sheets and more.
        Launch Adobe Bridge and navigate to a 
folder containing new images. Use the cursor 
keys to quickly flick through the images and 
click below a thumbnail to add a star rating, or 
use the keyboard shortcut Cmd/Ctrl+1-5. You 
can then filter your images by the star rating to 
group the ones you want to work on.

   The next step is to open the images 
from Bridge into Adobe Camera Raw. ACR 
is the best place to make initial changes to 
your images to boost tones and correct any 
problems with exposure and so on. It doesn’t 
enable you to combine images – you’ll use 
Photoshop for that – but it does enable you to 
make the kind of edits photographers need.
      In Photoshop, you can further refine 
the image with layers and adjustment layers, 
which offer a much more flexible way of 
working than ACR. Once you’ve finished, it’s 
time to share it with a wider audience. Go to 
File>Save, and your image will be saved as a 
Photoshop document (PSD). This keeps all the 
layers intact, which means you can go back and 
retweak the image at a later date. However, 
PSD files are large and take up lots of hard drive 
space. If you want to share your images online 
or via email or social media, save them as JPEGs.

Manage your photos from capture to output in three stages

2

1

3



Discover how to process your raw files to perfection

The latest version of the raw file 
processor included with Photoshop is so 

powerful that most photos can be processed 
entirely in the raw processor, with no need for 
further editing in Photoshop. And by making 
your adjustments in Adobe Camera Raw 

rather than in Photoshop, you’ll ensure the 
best possible image quality, because raw files 
contain more picture information than bitmap 
images such as un-layered PSDs and JPEGs. 
Here’s our reference to the features you’ll use 
the most in the Basic panel.

THE BASIC 
PANEL IN ACR

TEMPERATURE
Use this slider to warm 
or cool an image if the 
White Balance tool fails to 
correct a color cast

CONTRAST 
Makes light pixels brighter 
and dark pixels darker

CLARITY
Controls the amount 
of midtone contrast

SATURATION
Controls the overall color 
intensity of the image

TINT 
This slider enables you to 
correct a green or magenta 
cast, again, if the White 
Balance tool fails

HIGHLIGHTS 
Controls the brightness 
of the lightest pixels

EXPOSURE 
Controls the overall 
brightness of the image

BLACKS 
Sets a point on the tonal 
range at which pixels 
should be pure black

SHADOWS
Controls the brightness 
of the darkest pixels

WHITES 
Sets a point on the tonal 
range at which pixels 
should be pure white

VIBRANCE
Adjusts the intensity of 
the less-saturated colors



The six most frequently used Photoshop layers for image 
editing, and how to use them to improve almost any photo

Photoshop has many types of layers 
and adjustment layers available, but 

there are six that you’ll find you need to use 
again and again. Learning how they should be 

used may seem a little daunting for beginners, 
but once you’ve got to grips with them, you’ll 
find they play a part in the creative process of 
almost every image you make.

02 CURVES
Curves is one of the most powerful 

adjustment layers. An S-shaped curve 
brightens the highlights and darkens the 
shadows, resulting in extra contrast. Create 
a Curves Adjustment Layer and click the 
middle of the diagonal line to add a central 
control point. Drag down on the lower part 
of the line and drag up on the upper part of 
the line to improve image contrast.

01 LEVELS
This should be the first layer you add 

to an image, because it fundamentally alters 
the tonal range of the entire image. Create 
a Levels Adjustment Layer, drag the Black 
Point slider inwards until it touches the left-
hand edge of the histogram, and drag the 
White Point slider inwards to the right-hand 
edge. This remaps the tones of the image to 
make more of the available tonal range.

03 HUE/SATURATION
This adjustment layer is best used 

for altering the intensity and brightness 
of individual color channels in an image – 
greens and blues in landscapes, for instance. 
Create a Hue/Saturation Adjustment Layer, 
click the Master menu and choose the color 
channel you’d like to adjust. Small changes 
are usually the most effective.



BEFOREAFTER

06 SELECTIVE SHARPENING
Once all other adjustments have 

been made, you need to sharpen the image 
for output. The traditional way is to create a 
merged layer at the top of the stack, apply 
Unsharp Mask, then paint on the mask to 
remove the sharpening from those parts 
of the image you want to remain soft. 
However, the Sharpen tool enables more 
control over the process by enabling you to 
build up the effect by brushing repeatedly 
with a low opacity brush. Create a new blank 
layer, select the Sharpen tool, tick Sample All 
Layers and set a Strength of 50% or lower.

05 DODGE AND BURN
One of the best ways to enhance a 

photo is by lightening or darkening selected 
areas of the image. This can be done with 
the Dodge and Burn tools, but rather than 
use them directly on the image, a separate 
grey layer gives you greater control. To 
create a Dodge and Burn layer, hold down 
Alt and click the Create a new layer icon in 
the Layers panel. Give the layer a name, 
then choose Mode: Overlay. Check Fill with 
Overlay-neutral color and click OK. Now use 
the Dodge and Burn tools (with Range set to 
Midtones) to work on the new layer.

04 HEALING LAYER
Most photos contain unwanted 

marks or blemishes. The Spot Healing Brush 
tool is effective at removing these. The best 
way to apply the healing is on a new blank 
layer, so that you can easily tone down or 
remove selected healing work later without 
having to start from scratch because you 
healed directly on the background layer. To 
do this, create a new blank layer, choose the 
Spot Healing Brush tool from the Tools panel 
and tick Sample All Layers on the Options 
Bar, then continue as normal.



D
Reset the foreground and background colors 
to black and white

ALT+[SCROLL WHEEL]
Zoom in or out of the image

[ OR ]
Resize the brush tip

CMD/CTRL+SHIFT+ALT+E
Create a merged copy of all the layers in the 
layer stack

SHIFT+[ OR ]
Cycle backwards or forwards through the 
layer blend modes

SPACE BAR
Temporarily switch the current tool to the Hand 
tool, for moving around the image while zoomed in

CMD/CTRL+[LAYER MASK]
Load the currently active layer mask as 
a new selection

ALT+[EYE ICON]
Switch off the visibility of all other layers in the 
layer stack, for before-and-after comparisons

CMD/CTRL+T
Activate the Free Transform tool

CMD/CTRL+I
Invert the color of a layer mask to black

SHIFT+[LAYER MASK]
Disable the effects of a layer mask

CMD/CTRL+J
Duplicate the current layer

X
Switch the foreground and background 
color swatches

14 keyboard shortcuts that will massively improve your 
speed and efficiency while working in Photoshop

CMD/CTRL+ALT+Z
Undo the last change made to the document. 
Works multiple times
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